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WELCOME 

Hello and welcome to EmbroideryWorks! Thanks for reading this User Guide! Since you’re here, let us tell you 
some things about this exciting program because EmbroideryWorks represents a giant step forward in machine 
embroidery. It requires no hardware dongle and can be installed on multiple systems requiring only your personal 
serial number to be typed in for the program to run. Once you enter a serial number, you can register the program, 
which provides several benefits. One of those benefits is that if you should ever lose your serial number, we can 
recover it for you. 

This manual covers the features in the program versions Everyday and Advanced.  The idea behind Everyday is to 
include the features, which are essential for every embroiderer, yet not to overwhelm the user with unnecessary 
extras. It is designed to be simple and easy, yet powerful enough to accommodate the person who wants to do 
more than simply using existing designs. 

The program version Advanced adds some very useful tools and settings which make life easier for a user who has 
some experience with embroidery. If you’re new to embroidery and have purchased Advanced, please don’t worry; 
these features will not get in your way. They are easy and fun! And once mastered, will provide valuable assistance 
with your embroidery projects. 

Everyday Features 

• 12 Fonts for multi-line text, monogramming and circle text. 

• Sample designs which are scalable and recalculate their stitches as you interactively transform them. 

• Unlimited lines of letters or monograms and embroidery designs can be combined. 

• The Project Advisor which helps you with stabilizer, needle and other advice for your project.  

• The Sweep Tool which reduces stitch count, time and puckering. 

• You can mix and match fonts and sizes. 

• Merge existing embroidery files into your design. 

• Use your Designer’s Gallery Studio catalog for easy access to your designs and cataloging. 

• Our patented Density Map to evaluate designs without needing to sew them. 

•  If you overlap designs, Everyday will remove the overlapped stitches so the design will sew perfectly.  

• Browse and Merge designs in folders and from inside .ZIP files. 

• Resize existing embroidery files with stitch recalculation. You can resize embroidery within everyday up 

to 250% and down to 50%. 

• Adjust density of designs, including separate adjustments for Satin and Fills, per color 

• Automatically split designs into our pre-defined Multi-Position Hoops. 

• Colorize any embroidery design. You can change the colors one at a time, or convert the entire design or 

any selected part of it to your preferred thread brand with just a few mouse clicks. 

• Simulate the sewing of any design. The simulator can play in 3D, a play forward and backward, and has 

variable speed.  The simulator also has a slider so that you can manually scroll forward and backward 

through the design to any point without waiting. You can even insert a color stop in the sewing process.  

• Convert any design from one format to any of the supported types, which include: 

• Read: ART, CND, CSD, DST, DSZ, EMD, EXP, EXP+, GNC, HUS, JAN, JEF, JEF+, PCM, PCS, PEC, 

PES, PHC, SEW, SHV, TAP, VIP, VP3, XXX, EMB. 

• Write: CSD, DST, DSZ, EXP, EXP+, HUS, JEF, PCS, PES (v1-9), PCM, SEW, SHV, TAP, VIP, VP3. 

• Designer 1 Disk utiltiy for floppy and USB machines.  
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• Create a working file (.BE extension) to save your design as an editable and merge-able file. Your work-

ing file is saved for you automatically when you save a stitch file so you don’t have to ‘Save’ twice every 

time you make some changes—once for the stitch file and once for the working file. 

• Real Scale zooming allows you to view your designs on screen at the actual size that they will stitch out.  

• Navigation Window that provides instant control over the zoom and scroll in the program’s view. 

• Sewing Order control allows you to re-sequence the designs to sew in the order you want them to sew. 

• Color Sorting control to intelligently reduce the number of extra color changes. 

• Adjustable Mouse Wheel attribute for Zoom or Scroll. 

• Simple centering in the hoop plus advanced alignment. 

• Thread Palette creation and thread inventory system. 

• Basting designs. 

• Create Applique cut files for most cutters. 

• Display and print cropped photo as applique – eliminate cutting in the hoop! 

• Add knockdown stitching for sewing on towels 

• Automatically check for updates.  

Advanced Components (additional features)  

• 32 additional fonts for multi-line text, monogramming and circle text. 

• Import Fonts, a great feature to work with alphabet design packs. The alphabet design packs are easily 

mapped into the font list, turning the letters into a keyboard font. 

• Stitch Editing, including Split, Insert and Delete, Pull compensate and adjust stitch. 

• Custom Multi-Position Hoops. 

• Advanced stitch adjustments. 

• Extra Library design sets for Appliqué and more. These can be used with your existing designs. 

• Our StitchPerfect system, which adjusts the design to better sew on your project. 

• Precision tools for design placement. 

• Repeat designs for tiling. 

• Full featured Thread Chart creation, including metallic and variegated color creation. 

• Baste design and hoop. 

More About the Fonts 

These fonts give you enormous control over them. The specifics vary depending on which lettering style you’re us-
ing, but in general, you can adjust the font, color, size, aspect, center, rotation, mirroring, slant, kerning, layout, 
stagger, sequence, envelope shape, stitching properties including density, underlay, underlay density and compen-
sation (which can be used to increase boldness) for the design as a whole. And you can adjust the color, size, posi-
tion, rotation, kerning, aspect and mirroring down to the individual letter. You can adjust the letter sequence for 
Monograms so that letters may overlap exactly how you want them. And if you do overlap your letters within a 
Monogram, the hidden stitches are automatically removed for you so that the design sews out nice and flat. For fast 
and easy Monogram setup, you have 14 Quick Styles to layout your design, including Vertical, Square, Oval and Di-
amond. 

When sizing letters, your letters automatically switch to a fill-like satin stitch. This looks like a fill, but unlike a fill, 
the stitches maintain the beauty of the curved satin column. Another benefit of this is that fonts can be made far 
larger than ordinary embroidery fonts - some as tall as 8". 

To make the fonts even more versatile in size, automatic adjustments are made for you to help the letters sew 
smaller than they would in other programs. For instance, when you make the letters smaller, narrow satin stitching 
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is automatically adjusted to keep long-enough stitches to actually sew. And although some small designs look good 
on screen, they won’t embroider well. The fonts in the program protect your stitching automatically. 

Multi-Line text offers line spacing, and in Circle Text, you can keep on typing, right into a spiral! 

And EmbroideryWorks can further be extended by adding font and design packs, including those for Monogram-
Works, now available from your dealer or online at www.designersgallerysoftware.com.  

 

Welcome to EmbroideryWorks, and let the fun begin! 
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INSTALLATION 

Installation of EmbroideryWorks is easy. First install the disc or download the installer. If you have the disc, XP 
may automatically run it, but in later versions of Windows, Auto-Run has been turned off by Microsoft, so you’ll 
have to browse to it using Windows Explorer (a.k.a. “Computer”). Look for the program with “Setup” in the name 
and double click on it. This will start the installation. In Windows it looks like this: 

     

Click ‘Next,’ then accept the license agreement by clicking the button, then click ‘Next,’ 

     

Click ‘Next.’ You will usually want a desktop icon for ease of running the program. Click ‘Next,’ 

     

You are now ready to begin installing. Click ‘Install,’ 

You can run EmbroideryWorks now, or you can just quit the setup by unchecking the Launch box. 

 

You are finished installing. Please have your serial number(s) ready for the first time you run the program 
so you can get started right away!
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OVERVIEW 

Below is a picture of the EmbroideryWorks window: 

 
• As with most programs at the top of the window is the Main Menu, and below the Main Menu is the 

Main Toolbar. These two components are always available and handle the most significant commands of 

the program. 

• The Tool Pane is a little different. It will display different contents, depending on what type of task you 

are performing. For instance, if you are running the Sewing Simulator, the controls for the simulator will 

appear in the Tool Pane. 

• The Main view displays the current Design Page. A Design Page is a representation of a .BE file, which 

can contain multiple embroidery designs, lettering objects and frames. 

• More than one Design Page can be open, and these are selectable by using the tabs above the Main View, 

just below the Tool Pane. As you save Design Pages, they will take the names you have given them. Un-

til a page is saved, it will be called “Untitled...” 

• The Status Bar provides relevant information about what is going on with the program’s current opera-

tion. For instance, if you are measuring items, the text in the bottom right corner of the Status Bar will 

update with the measurements created by that tool. 

• The Navigation view provides an easy-to-use way to navigate around the current design page, and to con-

trol the zoom for it. This is especially useful when you have a lot of objects on a large design page and 

you want to go from one place to another without repeatedly zooming and scrolling. 

• The Objects view displays Designs and Objects sequential order as they are opened or merged onto the 

design page.  Each root (leftmost) item in the Objects view is a Design. A Design or object may be, for 

example, a lettering design, or perhaps a regular embroidery design. 

• The Designs in the Objects view can have objects within them. To view those objects, click the ‘+’ which 

opens up the tree, thereby ‘disclosing’ the objects in the design. With a normal embroidery design 
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merged into the page, you will be able to see individual colors within the design once you click the ‘+.’ 

Some designs, like lettering designs, may not disclose their individual objects because all editing is done 

via the Properties view. 

• The Objects view can also be used to select designs and objects, which is useful when objects within a 

design are grouped, such as with regularly merged embroidery designs. 

• The Properties view displays information and controls for the currently selected objects and designs. For 

example, if a single-color design such as lettering is selected, you will see in the ‘Color’ property page 

only the single color for the lettering. If no design or object is selected, the Color property page is shown 

and the colors for the entire design page are shown. 

 

The EW Library Window 

The EW Library window is used to merge designs into the current 
Design Page. 

 

Individual design collections will appear on the left. These collec-
tions are ones that are included in EmbroideryWorks and Mono-
gramWorks. They are special designs because they will generate 
their stitches dynamically as you size them, similar to the letter-
ing.  

 

Clicking on a collection icon on the right will result in the designs 
from that collection to appear on the left. To import a design, se-

lect it and click OK. You can also double-click on a design to import it and close the window. 

 

The Stitch Files Window 

The Merge Files Window is used to merge existing embroidery files into the current Design Page. 
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The Browse view on the left side is called a ‘Tree’ control, and it has a ‘Root’ level, which is left-most and ‘branches’ 
which you can open and close using the ‘+’ and ‘-‘. You will also see individual .ZIP files as branches, so you can im-
port designs directly from within those as well. 

On the toolbar, there are controls for thumbnail size and 3D display. The ‘Close’ button will close the window with-
out importing anything. 

The “Sel. All” button selects all the designs in the view on the right. 

To bring designs in, click ‘Import’. 

Note: There are two tabs visible, ‘Browse’ and ‘Catalog’. The catalog tab is used for working with files that have 
been categorized in Designer’s Gallery Studio. If you do not have a Catalog tab visible, then the program was not 
able to find a Studio catalog. 

As with most views like it in Windows, the thumbnail view on the right allows single design selection, by clicking 
on an item. But also you can select a range of designs by first selecting a design then holding the shift key down and 
clicking another design. Additionally, you can use the control key to click on different designs that are not next to 
each other, and that will select those too. This is called a disjointed selection. 

You can also double-click on a design to import it and close the window. 

When the Catalog is available, you can drag files onto keywords in the catalog, the same as you would do in Studio 
or Studio III. You can also right-click on the catalog keywords to add, edit and change keyword entries. This is the 
same catalog file as used by your Studio, so any changes you make will be available in both programs. 

Design Pages 

A Design Page is where designs and lettering can come together to form a composition or a scene. That page is also 
represented as a single embroidery (or working) file. For example, you may have merged multiple embroidery de-
signs, added a couple lettering designs, and then surrounded them with a Library frame. All those individual de-
signs exist on the Design Page. That scene can be saved as an embroidery file for use in your machine, and it can 
also be saved as a ‘Working File’ (extension .BE) which allows for editing later. (Suppose you miss-typed some let-
tering.) 

As Design Pages are opened or saved, their name will appear in the Tabs above the Main View. You can switch be-
tween Design Pages using the Tab View. This is handy for clipboard operations such as doing a copy and paste be-
tween Design Pages. 

 

Designs 

Each Design on a Design Page is one of the three types, ‘Embroidery Design,’ ‘Lettering Design’ and ‘Library Design.’ 
These design types work together to build useful embroidery compositions. The designs are visible on the Design 
Page in the Main View, and the sequence of the designs is visible in the Objects View. 

Designs are collections of objects. For example, a merged embroidery design is a collection of color objects, each of 
which contains stitches for a single color in the design.  

Designs may be ‘Grouped’ which allows you, the user, to select and move the design around in the Main View as a 
single design. By default, when you merge an embroidery design into the page, it comes in as grouped. If you want 
to change one or more colors (or objects) in the design, you have some options: 

Ungroup the design, which makes each object selectable in the Main View. 

Select the object or objects in the Objects View. 
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Designs as they appear in the Main View may be ‘Locked’ which prevents inadvertent moving or editing. The lock 
may also be used to hide the design(s). The state of the Lock is set using the Objects View toolbar. 

Objects 

Each Design on the design page can contain one or more objects, each of which contains colors, stitches and other 
information. The only objects you will see are individual color objects within a merged embroidery design. Each 
object can be moved, edited, deleted, etc. 

The Windows Docking Pane Interface  

This interface can be configured and the configuration is persistent, i.e. it is remembered between program invoca-
tions. The controls for this interface consist of a Pin, a Close Box and a Tab. The Pin and Tab are related. When the 
Pin is “unpinned” the window slides into the main window frame and presents a Tab with the window name. When 
the Pin is “pinned” the window stays open and the Tab goes away. 

In the unpinned configuration, hovering the cursor over the Tab reveals the window. When the cursor is moved out 
of the window it slides back into its unpinned position. 

The Close Box dismisses the window altogether. To restore a dismissed window you must use the View Menu-
>Toolbars and Windows item to restore the dismissed window. 

   

Left: Unpinned     Right: Pinned 

 

    

Left: Pinned Windows.  Right: Reset Windows command in Menu. 

Files 

EmbroideryWorks uses a few different file types, each having its own file extension. For example ‘.BE’ is a working 
file. This file type contains all the Designs and Objects representing a single Design Page. These designs and objects 
can be edited, as they have not been forced to become a simple set of stitches, which is what most machine-
embroiderable files are. 

Licensed files, such as fonts will have .BF and .LF files. These are installed by the installer for our collections. You 
cannot edit or use these files as a user. The program loads them automatically as needed. 

Stitch files, which in the commercial embroidery trade are called ‘expanded’ files such as .PES or .DST are simply 
collections of stitches, and if you are lucky, colors. 

Saving 
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When you save a Design Page it will ask you to choose which Stitch File type you want to use. For example a Baby 
Lock / Brother embroidery machine owner will choose .PES as the stitch file type. In addition, the program will al-
so silently save a working file (.BE) thus saving you the extra step of saving it separately. As mentioned earlier, the 
working file allows you to edit your designs including text. If you want to save individual files (not both stitch and 
working) you have all the options on the File menu. 

Open vs. Merge  

Files can be ‘opened’ which starts a new Design Page in the Main View so that you can see the open file. Use Open 
for .BE files. 

If you already have a Design Page open, you can ‘merge’ files, which adds the contents of the files to whatever you 
have on your page currently. To merge a file click on the Merge icon on the Toolbar or go to File/Merge Stitch file 
or Merge Working file
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THE MAIN VIEW 

Design pages are displayed in the Main View of the program. There can be multiple design pages open at any given 
time. For each page in use, a Tab control is displayed at the top of the Design page. Additional Design pages are 
added by clicking the New button on the Main tool bar, by pressing Ctrl-N by choosing New Page from the File 
menu or choosing New from the Window menu: 

        

A design page is activated by clicking its Tab control. Or you can select it from the list in the Window menu. 

 

The Tab control will display the name of the file associated with the page once it has been saved, otherwise it is 
named “untitled x” where x is a running number. 

 

The Main View has a background, a hoop, and rulers along the side and, naturally, the designs you have placed in 
the Design Page. 

 

 

Zooming 

Zooming is handy for edits, and this makes the process of zooming more convenient. Also, 
one of the options in the program is to be able to use a mouse wheel to scroll the design page 
up and down. If you have this mode on, the zoom slider is another useful tool. Just a remind-
er, there are also keyboard shortcuts for zooming: ‘z’ zooms in, and ‘Z’ (shift-z) zooms out. 
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Zooming can also be accomplished with the Zoom Menu and Toolbar controls. 

• ‘All’ zooms to all objects on the design page. 

• ‘Selected’ zooms to selected objects on the page. 

• From the Zoom menu specify what should be zoomed: the Hoop, All elements or the Selected element or 

choose the amount of zoom. 

Tip: Memorize the keyboard shortcuts for the Zooming and Panning; using them can speed your designing! 

 

Use the Zoom slider to zoom on the Main view. Up zooms in, down zooms out.  

There are zooming keyboard shortcuts: 

• ‘z’ to zoom in 

• ‘Z’ to zoom out. 

• 0 = Fit Hoop 

• ‘A’ to zoom all 

• ‘S’ to zoom selected 

• 1 - 9 will zoom to 100%-900% of real-world scale. 

 

 

Magnify  

  

The Magnifier on the Main toolbar will let you change the zoom in three ways after you click on it: 

 

 

• Left-click to zoom in 

• Right-click to zoom out 

• Drag a rectangle to zoom on just that area. (This will also cancel the tool.) 

 

Note: The Overview or Navigation window can alter the zoom too, and we’ll cover that in its own chapter. 

 

Measure Size and Counts (Stitches and Colors)  

  

The Measure button on the Main toolbar will set the program in a mode, which allows you to measure 
items in the Main View. 

 

As you drag the cursor, you are measuring the distance you’ve dragged. This distance is displayed on the status 
bar: 
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To cancel measuring, click again on the Measure button in the toolbar, or click the Selection Tool (arrow) in the 
toolbar. Items that are selected also have their size, stitch count and color count shown in the status bar. If nothing 
is selected, then the size and counts for the entire Design Page will be shown. 

 

 

Viewing in 3D 

The default setting for the Main View is to display stitches in a realistic 3D, which lets you easily see 
where the needles will penetrate the fabric. This can be turned off using the ‘3D’ button on the main 
toolbar. 

Background and Grid  

You can alter the background of the Main View. Click the Preferences button on the Main toolbar. This will 
bring up the Program Preferences window, which allows you toset many program and Design Page op-
tions. Click on the Grid Settings to adjust them. 

 

To change the background color, click the Color button, which will display a standard color picker: 

 

You can even create your own colors and add them to the custom colors section. 

Select a Custom color and click OK to set the new color. 
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Adjustments: 

• The Grid is adjustable too. You can alter the display of gridlines by choosing between lines and dots. 

You can also set the spacing of the grid, and that can be set separately for both metric and inch settings.  

• The arrow buttons, labeled “>>” and “<<,” will copy the settings from inches to metric and vice versa. 

Thus, you can set up a grid that has metric spacing for machine/hoop accuracy, but can display infor-

mation to you in inches. 

• Snap-to-Grid will help align objects to the grids as you move them in the Main View. As you move in 

one direction (up, down, left, right) the edge of whatever you are moving will ‘stick’ like a magnet to the 

grid as you approach a grid line in that direction. If you want to overcome the snap-to-grid, you can pass 

the grid and then come back in the reverse direction. (Which means the opposite edge will want to snap 

to some other grid.) 

• Grids do not force you to stick to them when Snap-to-Grid is on. Rather, it merely enables the snap as 

you get close, which may help with precision alignment as you move things around. 

• Using the menu or the Grid button on the toolbar, you can turn the Main View display of the grid on and 

off. 

Hoops 

• The hoop that you will view in the Main View is chosen for the Design Page using the Preferences Win-

dow also. 

     

Left: Hoop selection.     Right: This is what a hoop looks like in the Main View. 

 

Using this window you can select different hoops, the selected hoop to be shown rotated 90°, add new hoops of 
your own creation or edit the selected hoop. The ‘Defaults’ button reloads the hoops that are installed with the 
program. This is useful if you update the program or have previously deleted some default hoops. 

Note that when you create a new hoop or modify an existing hoop, that you are really defining the sewing area, or 
what is known as the sewing field, not the physical dimensions of the hoop. You must know your machine’s em-
broidery field as you cannot create a hoop that is larger than what your embroidery machine can sew. 

 

Display Calibration 

The Main View is calibrated to a real-world scale for precise display of designs. Use the Preferences Window to cal-
ibrate your display for real-world size: 
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Hold a ruler up to your screen and adjust the slider until the measurement in the program matches your real-world 
ruler. This will help you better estimate real design size while editing designs. 

The Mouse Wheel 

The Mouse Wheel can zoom the Main View in and out. It can also be used to scroll the page up and down. We rec-
ommend that you use the setting that allows for zooming as this is more useful to most users. 

 

Ghost Mode  

Ghost Mode is an option relating to how the Main View displays objects when not selected. The idea for Ghost 
Mode is to make it more obvious which objects are selected by fading out those items that are not selected. 

 

Left: Ghost Mode on.     Right: Ghost Mode off. 

 

The intensity of the Ghost Mode can be altered with the Preferences. 
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Panning and Scrolling  

The scroll bars at the right and bottom of the Main View can be used to scroll the view around, which is very useful 
when you are zoomed in. 

There is also a mode that allows you to ‘Pan’ the design, which works like a scroll, but where you move the view by 
dragging the mouse. Hold the space bar down and drag the mouse to pan the view.  

 

 As you drag on the main view, you may come near the edge of the page. This will cause the page to scroll thus ena-
bling you to drag into a position that’s not currently in view. 
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Selection 

 

One of the most common tasks in the Main view is to select items. Using the Selection Tool (Arrow but-
ton on the main toolbar) you can select and move items in the design page. Select items by clicking on 
them. This will place ‘handles’ and a dotted line around the selected items. 

 

You can also see that items are selected by looking in the Objects view. Another way to select items in the Main 
view is to drag a rectangle around those items. Anything completely in the rectangle will be selected. However, if 
an object is grouped with something outside the rectangle, it will not be selected. 

Status Bar 

 

 

 

The status bar is located at the bottom of the program window. Size, stitch count and color count information ap-
pear on the right side of the status bar. If you have no design selected, then the display will contain information 
about the entire design page. If you have something selected, then the information contains the word, ‘Selected’ 
and represents only those selected items. 

You can double-click on the size information in the status bar to quickly switch between metric and inches on the 
design page and status bar. 

The status bar also has a line of text on the left that can provide additional information about an onscreen control. 
Hover the mouse over a control, specifically a toolbar button, and the status bar may provide additional clarifica-
tion of what the button does. 

 

NAVIGATION 

The Navigation H.U.D. (Heads Up Display) is an ingenious device that keeps navigation tools readily availa-
ble, yet tucked away, for easy access to the entire working area on your Design Page. To access the Naviga-
tion H.U.D. (aka: Nav H.U.D.), click the Compass Rose icon at the top of the zoom slider in the upper right 

hand area of the main view.  
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The Nav H.U.D. is especially useful when working on large designs and/or a small monitor. It quickly gives you a 
bird’s eye view of your work area as well as a nice “you are here” indicator. In the following image, the area around 
his eyes will be centered on the screen. 

 

As you move the cursor, the ‘+’ indicates the area of focus. The panel lets you pan around the design page. The ben-
efit is that you can make edits to different design sections while you are still zoomed in to a comfortable level.  

 

 

The Nav H.U.D works in conjunction with the Pan Tool, which is accessible by holding down the spacebar.  

Hold the spacebar and drag with this cursor to pan. 

 

Whereas the Pan Tool is useful for moving around the area you are currently working in, the Nav H.U.D. makes it 
easy to scroll across the entire page to a specific place in one easy step. 

The chosen hoop is shown in the Nav H.U.D. whether that hoop is visible or not. This is because the size of your 
workspace is related to the size of that hoop. The selected hoop is a visual reference only and does not prevent you 
from designing or saving projects larger than the selected hoop or, for that matter, larger than your machine can 
sew. 

Therefore if you have a small hoop selected and a design that well exceeds the hoop boundaries, it is possible that 
you won’t be able to navigate to the outer reaches of your design. The solution is to select a larger hoop from the 
Environment > Hoops option in the Program Preferences panel. 
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Same design with the hoop set to 60mm x 40mm with the cursor shown at the upper left limit. Parts 
of this design are inaccessible. 

Normally, once you’ve panned or zoomed in the Nav H.U.D. the panel will automatically close when you release the 
mouse. If you’d like to leave the Nav H.U.D. open while you move to several locations, click the ‘Pin’ button just to 
the left of the close box. Once pinned, the panel will stay open until you click out of it, or click the ‘Close’ button on 
the top, right in the H.U.D. 

 

     

Unpinned (default setting)  Pinned 

 

Notice on the top of the Nav H.U.D. are three small buttons labeled ‘A,’ ‘S,’ and ‘H.’ These buttons correspond to pre-
set zoom settings of ‘All,’ ‘Selected,’ and ‘Hoop,’ whose keyboard shortcuts are respectively ‘A,’ ‘S,’ and ‘0.’ 

Just below the compass rose icon is a zoom slider. Slide up to zoom in; down to zoom out. Click on the ‘+’ and ‘-’ 
buttons to zoom in and out also. If you’ve ever used an online map, this zoom slider control should feel familiar. 
The slider control also responds to numeric key entry. For example, pressing 5 will move the slider control to 
500%.  

OBJECTS VIEW 

 

The Objects view shows the designs that have been opened or merged onto the 
Design Page and objects within those designs. 

 

Notice that the designs are numbered in the Objects view. The designs or objects 
are numbered in the order that they have been opened or merged onto the de-
sign page. In the illustration above lettering was opened onto the Design Page 
first. So, it has been numbered 1. The following merged design is number 2 in 
the sequence. When re-sequencing objects the numbers will change accordingly. 
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Using the Objects view designs may be selected, sequenced and deleted. The Objects view can display individual 
objects within designs where allowed. Stitch files (merged embroidery designs) are one example of a Design Type 
that allows the display of individual objects within the design. Clicking on the ‘+’ at the left of the design will ex-
pand that design in the Objects view. Under that design will then appear the individual objects. 

 

Using the Objects view, objects may be selected, re-sequenced or deleted. 

 

Auto-Scroll 

 As you drag on the Objects view, you may come near the top or bottom edge. This will cause the view to scroll thus 
enabling you to drag into a position that’s not currently in view. 

 

Selecting 

Using the Objects view you can select any number of Designs or Objects, re-
gardless of whether or not they are locked, hidden or grouped. This allows for 
editing of objects or designs without ungrouping. For example, the following 
design is all grouped so that it can be moved around the page as a single de-
sign. However, you may want to select just the second color to change it, re-
sequence it or even delete it. 

 

The toolbar on the Objects view also has selection options including ‘Select 
All’ which is the first button on the left. If the Main view is active you can also 
type Ctrl-A to select all or you can use the Edit menu for this option too.  

 

 

Reverse Selection 

The second button will reverse the current selection. This means that whatever you have selected will no longer be 
selected, but everything else will become selected. This is useful when you want to delete everything except for a 
single design element. 

 

Range Selection 

Using the Objects view you can select multiple designs or objects. If a single object is selected, you can use the shift 
key while clicking a second object and this will select a range of objects: Everything in between the two will be se-
lected. 

 

Disjointed Selection 

If you use the Ctrl key while clicking on objects, you can singly select designs or objects. To de-select an object 
that’s already selected, Ctrl-click on it. This will reverse its selected state. 

 

Graphical Selection 
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You can also drag a rectangle around objects in the Objects view to select whatever is in the rectangle. 

 

Note: Dragging enables Auto-Scroll, and your view will move allowing you to select items that weren’t ini-
tially visible. 

 

Selecting by Color 

If you want to select all objects of a given color, select one of the objects as described above. Then use menu option, 
Edit->Select by Color. This will find and select all the objects on the page which have those same colors in them. 
This is a handy feature to change the color of several things at once. 

Locking 

If you want to prevent designs or objects from being selectable in the Main View, you can ‘Lock’ them. Locking an 
object does not affect its grouping; it only prevents it from being clicked on. The second button, a white lock with 
an ‘X’ on it, will not only lock the design or object, but will prevent it from being displayed in the Main View. 

To unlock something, click the third lock, which appears as an open lock icon. 

Sequencing 

 

The sequence of objects and designs can be changed using the Objects view. 
One way is to right-click on a selected item which will cause a pop-up menu to 
be displayed. That menu has options to move items earlier or later in the se-
quence. 

You can also drag and drop items in the tree to re-sequence them. Dropping an 
item (let’s call it ‘B’) on another (called ‘A’) will place that dropped ‘B’ item 
right after ‘A’ in the sequence. If you drag an object onto the design icon, then 
that drop will be placed at the head of the design. 

You can also re-sequence selected designs and objects using the ‘Sequence Ob-
jects’ command on the Edit menu. 

 

THE PROPERTY SHEET 

 

When you have design or object items selected, there may be properties that you can 
adjust. The Property Sheet contains individual ‘Property Pages’ that let you adjust 
the selected items. The pages are displayed as tabs. Click on the tab to work with the 
design or object items that are selected. 

If nothing is selected, the Property Sheet will display the Color property page, which 
in turn will show every color in the Design Page. This is a convenience that allows 
you to change colors on the page. 

 

Note: Sometimes, users will confuse the Colors property tab with the Object View. 
You cannot select anything using the Colors property page. This page merely reflects 

what is selected and lets you change the colors on display. 
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The individual tabbed pages that you see will depend on the designs and objects that you have selected, and we’ll 
cover those individual controls in the respective sections for the design types; Lettering, Embroidery and Library 
designs. 

 

COLOR 

Color is unexpectedly influential. We may be initially attracted or repelled by an 
item or design simply because of its color. The ability to view designs in realistic 
thread colors is an asset to the embroiderer.  

You may want to recolor a design to better suit your tastes, to coordinate with 
the threads you have in your stash, or to color a design that you’ve converted 
from a format that doesn’t hold color settings, such as .DST. 

When you merge a Library design, create a lettering design, or merge a stitch 
file, the objects come in with the colors and the thread brand that the designer 
has assigned—even if you have another brand specified as preferred (more on 
that in a bit).  

If the merged stitch file is a .DST file or other format that does hold set colors, 
then threads cannot be matched to any thread brand and will simply be a list of 
generically named colors. 

 

Tip: If you’d like to get an idea of how your design looks on a particular color, 
you can change the background of your main window in Environment -> Grid 

Settings in the Program Preferences.  

 

Changing colors is done via the Color tab on the Property Sheet, which is the lower panel on the right hand side of 
your screen. The color tab displays the thread sequence of the design. Selecting a color swatch on the tab doesn’t 
select anything in the design; it simply allows you to select and apply a different color from any of the thread 
brands loaded into the program. 

When first getting acquainted with EmbroideryWorks, it may be confusing to see what looks like two color lists. 
The top list shows a tree-like structure of all the various objects in the current main window. This includes Library 
designs, letters, and any merged files. In the sample shown below, a single design has been merged and the design 
has been opened in the objects panel so that all the various objects can be viewed. 

Because this is a stitch file, each object is all the stitches that are contained within a given color. In this instance, 
when you compare the object list next to the color list, you’ll see that they match. For example, object 1:6 corre-
sponds to color six in the following samples.  
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The color tab will show the colors of the currently selected object(s). If nothing is selected, the list will show all the 
colors on the current design page. You can select areas of your design by clicking them in the object list. You can 
select more than one area by holding down the Ctrl Key.  

     

The colors list only shows the colors of the selected items. 

 

Thread Brand and Color  

There are three buttons across the top of the Color properties tab: 

Thread… Select a thread library to use and set a preferred thread brand 

1 Color… Make the design monochromatic (one color) 

Preferred Change the colors to the closest match in your preferred thread brand 

To change a thread color, simply click on the color swatch that you wish to change on the Color tab. The Thread 
palette will open up with the color selected in the original thread brand specified by the designer. You can select a 
different thread line  from the drop down menu and the program will find the closest match in that chosen thread 
line. 
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EmbroideryWorks includes a wide range of popular thread brands and lines. 

 

Note: In the case of a DST, TAP or EXP file, the Color tab displays a list of generic color names. This is because these 
formats have no color information in them. Using EmbroideryWorks you can color these designs, and when you 
save the working file, the colors will be saved there. 

Similarly, PCS, PCM and HUS formats have limited color palettes. Again, saving the working file will preserve your 
colorization, and you can print colorized design templates and color information. This is especially handy for com-
mercial embroiderers. 

 

Clicking one of these color swatches will open the thread brand that you have set as preferred (Madeira Thread 
Chest is the default). To change the color, navigate to the desired color and click OK. 

 

 

 .DST file shown with generic colors and the thread palette displayed. 
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Some thread lines only have thread numbers, while others have numbers and color names. You can search either 
line by thread number but you can only search by name if the threads have color names. Type in the color or thread 
number in the search box and click ‘Go.’ Or, you can simply scroll through the list and pick one that appeals to you. 
Once the color is selected, click OK to apply it and close the Thread palette. 

 

  

Threads can be searched by number or name. 

There are two buttons on the top left of the window, “Threads” and “Palettes.” Most colors you will choose come 
from a thread chart. However, if you have created a palette using the Thread Editor, or if you want to reuse a cur-
rent design page color, select “Palette.” 

 

The ‘Thread…’ button allows you to change thread brands or to set a preferred brand by choosing a thread brand 
from the pop down list. Once a preferred brand is selected, you can easily change all the colors in any design to 
your preferred brand by clicking, ”Use this as my preferred brand.”  

 

A thread brand can be selected on a per-design basis or can be made preferred. 

 

Note: Be advised that while this may be convenient for you, if your design has carefully chosen and blended colors, 
converting brands may cause a less than desirable result—especially if a “close match” does not exist in the new 
brand. 
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Left: Original Hemingworth colors.  Right: Shown using Brother Flesh Tones. 

 

The color list does not name the areas that are colored. For example, suppose you want to change the pink shorts 
on the mouse design to blue. An easy way to do this is to find the area in the Object panel and select it. The color is 
now isolated in the Color panel and you can easily click it and select a blue. 

 

Coloring Letters  

Coloring Letters works a bit differently. To color individual letters, click on the center of the letter to select it. Then, 
as before, click the color swatch to select a new thread color. 
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Color Sorting 

The “Happy Birthday” design has 6 unique colors but 13 color stops. To make it more efficient for sewing, 
you might like to optimize the sewing order to reduce extra color changes.  

Because letters added together are considered one object, you can’t selectively rearrange them in the ob-
ject tree. Fortunately, there is easier method accomplished via Color Sort, which can be accessed on the toolbar just 
to the right of the Undo and Redo buttons. 

 

Clicking the Color Sort button displays the following dialog window: 

 

Notice our design has been reduced by 5 colors. 

 

Click ‘Save It…’ to save the color sorted file as a stitch file. If you don’t change the name, the program will append 
“_sorted” to the end of the current file name. Your original working file (.BE file) is preserved and not changed. 

Color sorting can be useful in designs like this or designs that have poor sequencing. Color sorting in this program 
is intelligent, meaning it doesn’t indiscriminately combine all like colors together. It looks for layering and knows 
that some colors simply must be repeated.  

 

Note: Do use caution when color sorting. Some designers have intentionally added extra color changes either for 
design flexibility or to optimize registration. For this reason, always Color Sort a copy of a design! 
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Deleting Stitches by Deleting a Color  

Often you will want to delete a section of stitches from a design that has been merged. When those stitches are all 
grouped as one color this is easily accomplished using the Object View. Open the design using the ‘+’ in the tree. 
Next, select the color you want to delete. Next, choose ‘Delete’ from the Edit menu or use the ‘Delete’ key on your 
keyboard. 

Below, the first color of the design is selected. Simply press ‘Delete’ on your keyboard to remove the first color 
along with the stitches associated with it. 

Note: Another way to delete is to use the menu, Edit->Delete. 

    

Left: Color is selected.     Right: Color has been deleted. 

 

APPLIQUE 

When you select a color by clicking on it in the Properties window, you will see the color window appear. This has 
two tabs, the first of which is to change the color, as discussed in the prior section. 

The second tab is used to set applique states on the selected colors. This information is used by the program when 
removing overlaps, and adds other features such as saving a file for use in applique cutting machines. 
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When a color is assigned as ‘Applique Position’ or ‘Applique Material’ then that color becomes exempt from having 
its stitches removed. They are likely to be hidden, but they are necessary when sewing the applique design. 

Colors can be assigned as applique position or material in three ways:  

1.) Use the drop list on the Applique tab of the Color Window. 
2.) Right click on the color ship in the Property window and use the context menu. 
3.) Name the object in the Object Tree as Applique Material or Applique Position. The words can be abbre-

viated: “Appliq Mat” or “Appliq Pos” are acceptable 
 

Material  

The ‘Material’ layer is used strictly to prevent the removal of stitches – first in the sense that the material stitches 
themselves are not removed, but additionally that the fabric inside the applique can obscure earlier stitches. As it is 
not good to have bulky stitches underneath an applique, those are removed. By way of example, you might want to 
overlap two or more appliques, and where they overlap, you want the minimum stitches necessary. Note that some 
designs do not have a separate material tack-down color. That’s okay to leave off in most cases. 

Position 

The ‘Position’ setting is always to be found in applique designs – otherwise they would not be applique. The posi-
tion of the fabric is sewn down, and then the applique is applied. Using this information we can do some additional 
things in the software: 

1.) Generate a fabric simulation. The fabric is simulated using the chosen color of the object. You can 
change this setting, and the color itself ‘live’ in the window to preview the results. When you find a suit-
able setting, you can click ‘OK’. 

 
2.) Use an image such as a photograph or fabric swatch inside the applique shape. 

 
3.) Create a print that is cropped to the outline, making it easy to hand-cut pre-cut appliques. 
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4.) Print the cropped image on printable fabric or transfer paper for the effect of combined photography 

and embroidery. 

 
5.) Inflate the shape of the outline. When digitizers create a design that will be hand-cut in the hoop, they 

know that the embroiderer won’t cut exactly at the line of stitching. So when they make the ‘Material’ 
run, they often simply duplicate the ‘Position’ run – same size, etc. This creates an issue for Pre-Cut Ap-
plique as the ‘Material’ stitching will not catch the applique – it is exactly the same size. Using the ‘In-
flate’ when saving for cutting machines will create an applique that slightly hides the ‘Position’ and can 
be held in place by the ‘Material’ stitching. 

6.) The ‘Position’ is usually a simple enough set of stitches to be processed into output for an automatic 
cutting machine. These machines will take a file and use that to cut the fabric. Having cut the applique 
beforehand makes the embroidery process much more rewarding. 
 
The software analyzes the shapes created by the Position stitches and then creates a simpler output for 
the cutters, and saves it to their file. .FCM for Brother Scan ‘n Cut and the .studio Silhouette products, 
along with .SVG and .PLT files can be saved. Nearly every cutter can make use of one or more of these 
formats. 
 
Save the cut file and send it to your machine according to the manufacturer’s instructions. 

 

Generally speaking, applique steps are; 

1.) Set the colors as needed. 
2.) Save the cut file. 
3.) Save the design file (working and stitch) 
4.) Cut the applique. 
5.) Embroider the design. 
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Alternately, you can still use the image in a print process, and pre-cut the applique by hand. There are a lot of op-
tions! 

Important Notes: 

The type of stitching is important for the operation of the applique discovery process in the software. Generally, 
applique position steps are made from single running stitches, which may jump to other sections and/or holes. 
Most digitizers will do this simple run, and then add tie-off stitches at the beginning and end of each outline. Some-
times the outlines will not close perfectly, but the software overcomes this, as well as the tie-offs. But if the digitizer 
uses some other stitch, it is possible that the process will not be recognized as an applique when you want it to. The 
easy way to check is to turn on the fabric simulation. If that looks correct, you are good to go. 

Also note that the program is not converting filled sections into appliques. That must be done by the digitizer who 
created the design. This process is to make using existing applique designs easier and more fun. 

 

Preferences 

The Program Preferences have a setting under “Files->When Saving” that can be used to turn on/off the use of ap-
plique in the removal of hidden stitches. 

Also the use of the Program Preferences under “Printing” can allow selected colors to be printed. This can be useful 
for machines that scan in a printed output for the purpose of cutting, such as the Scan ‘N Cut. 

THE THREAD EDITOR 

The management of threads is a challenge for every embroiderer. And every embroiderer handles this differently. 
Some people are very organized and will colorize designs with only colors they actually own. Others resist chang-
ing threads at all. And of course commercial embroiderers ignore colors onscreen entirely and just run whatever 
colors the job calls for. 

The Thread / Palette Editor provides a place for you to manage which threads you own, create smaller palettes for 
specific projects, and even share those palettes with others. 

When choosing colors in the main program window, you are given the choice of picking colors from thread lines or 
palettes. The reason for this is to allow quick access to a current set of project colors, rather than taking the time to 
scroll through a long list of threads and their complete color lists. Often, an embroiderer is working with a set of 
colors repeatedly and selecting through a long list when you, “Just want that blue I’m using,” would be tedious. For 
this reason, there is a checkbox that is used to determine whether the color list is shown as a thread or a palette. 
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Note: For the purposes of discussion, the term “thread line” and “palette” are considered synonymous, except 
when discussing the above checkbox. 

The program ships with data for many thread lines, including some that may not be available to you in your area. If 
you would prefer not to have those threads show up in your list (while changing colors in a design), you can check 
the box labeled, “Do not display.” This does not hide the thread in the Thread Editor, only in the Thread and Color 
properties when working with designs and objects. 

The ‘Notes’ box can be used to type in any useful information about a particular palette. For instance, you might 
create a palette of colors for a particular job or project and you can enter information such as “The blue design 
matches the print on the front of the shirt.” 

Each thread brand or palette is stored as a file on your computer. As such, the toolbar has options for you to create 
new thread palettes, save a palette which you’re working on, and even delete a palette that’s no longer needed. 
These actions are performed by the left three buttons on the toolbar. 

Merging colors from different thread lines / palettes. 

The next button, ‘Merge’ will open a thread window that lets you select one or multiple colors to be merged into 
the current palette. Also, there is a Delete button which removes any selected threads from the current palette. 

 

 

When merging colors from another thread or palette, the ‘brand’ for those colors will take the name of the current 
thread. This is one difference between a thread and a palette. If you merge colors into a palette (the palette box is 
checked) then the colors will keep their original thread names. 

 

Sharing Palettes 

If you would like to share or import a palette, use the two buttons on the right of the toolbar. Sharing a palette is 
great when you are making a project that others will make too. 

Thread Inventory 

You can mark threads that you have in your personal inventory using the ‘Check’ and ‘Uncheck’ buttons: 

Multiple selections can be made using the 
Ctrl and Shift keys while selecting with the 
mouse. 
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Creating colors using the Advanced program version 

The Advanced version of the program adds the ability to create your own colors and add them to thread lines and 
palettes. To create a new thread or palette, click the ‘New’ button on the toolbar. 

Click the ‘Add Color’ button to create a new color entry in the current thread / palette. Type in its name and thread 
number, if those exist, then adjust the color itself. 

Using the ‘Sheen’ setting, you can alter how the thread will display when 3D rendering is turned on in the main 
display.  You can also input up to four variegated colors on a thread. Using the ‘Var’ drop-list (short for variegated) 
you select the number of colors used. There will appear a set of buttons ‘V1’-‘V4’ each of which allows you to select 
and set the color for that particular variegation. 

The color grabber tool will let you click in any window and pick up whatever color is under the cursor. This is very 
useful when you are building a thread palette from a document such as a .pdf or a thread manufacturer’s webpage. 
If you want to adjust the color visually, use the HSV (Hue, Saturation, Value) sliders until you get a color that you 
like. 

 

    

Left: A typical thread list.                                 Right: A variegated color in a user palette. 
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TRANSFORM CONTROLS 

Sizing and positioning of design elements can also be accomplished using the Size and Position controls panel lo-
cated on the Tool pane. The first control on this panel sets the unit of measure for the design page. The choices are 
millimeters and inches. 

 

 

 

The width and height of a selected design element can be precisely set by entering the desired value in the width 
and height text box and pressing the enter key. If an exact size is not known, the element can be sized as a percent-
age of its original size by entering a percent value in the percent text box and pressing the enter key.  

 

These controls are also updated as a design element is moved or re-sized using its handles. 

The element is scaled proportionally if the Scale Proportionally control is locked, otherwise height and width 
changes are applied individually. 

 

Locked—Scale Proportionally 

 

Unlocked—Scale Height and Width Individually 

 

Note: If you have sized an element and want to return to its original size, simply lock the Scale Proportionally con-
trol and enter a value of 100 in either of the percentage fields. EmbroideryWorks will remember the original size 
even when you reopen the design at a future date. 

Mirror and Rotate  

The next four controls mirror and rotate selected elements. Mirroring is about the horizontal or vertical axes. Rota-
tion is clockwise or counter clockwise in 90 degree increments with the pivot point in the center of the selection. 
Alternatively, you can enter a specific value for the degree of rotation. Enter a positive value to rotate counter-
clockwise and a negative value to rotate clockwise. 

 

Centering In the Hoop  
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Centering in the Hoop can be accomplished by this button, although it is not necessary because, as a rule, 
designs are centered when stitch files are saved.  This is also available from the Utility menu. 

 

Fit to Hoop  

Design elements can be scaled up to the design page by selecting them and clicking the Fit Hoop tool. This 
will recalculate stitches wherever possible. There are limits, though, such as with regular embroidery de-
signs, which can only be sized up to 250%. This button will scale your design as large as it can go, up to the 

built-in limits. 

 

Remove Hidden Stitches  

When designs are overlapped, there may be stitches that are hidden, which you would like to have re-
moved. This process is automatically done when you save a file (controllable by preferences) but you may 

want to preview the results before saving. The Remove Hidden Stitches will run the process on those stitches so 
that you can evaluate the result. The result is temporary, however, so if you change anything on the design page, 
the stitches will return. This happens because changing a design will almost always regenerate its stitches. 

Size and Move 

The lettering, the Library designs and the merged stitch files can all be sized and moved.  

Existing embroidery files can be resized with stitch recalculation. You can resize embroidery up to 250% and down 
to 50%. If you want to resize an existing design without stitch recalculation, hold down the Ctrl key while dragging 
the handle. 

• Click and drag on a black handle to resize the design.  

• Click and drag the round blue handle to rotate the element. 

 

Black handles resize, round blue handle in upper right rotates. 

 

Click and drag anywhere on a design element to move it. As the design is moved off the page, in any direction, the 
page will automatically scroll if the cursor is in the ruler area of the page. For finer movements (1mm at a click), 
the selected design element(s) can be nudged using the keyboard arrow keys. To move objects one stitch point at a 
time (.1mm); hold down the control key while pressing an arrow key. 

When resizing, understand that not every design can be recalculated perfectly. Some designs such as cross-stitch 
and freestanding lace are not going to resize correctly. Another consideration is the level of detail. Highly detailed 
designs radically reduced will lose clarity and crispness as the details become squished together. 

Note: This is one major benefit of the Library designs; they can usually scale and calculate their stitches for you. 

 

Align and Distribute  
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Alignment of multiple items can be set using the Align button, which will open the Align and Distribute 
window. Alignment will place the edges or centers of designs all on one line. 

  

If you have two or more items selected, you can align them.  For example, these items are Aligned Left: 

 

Distribution is different from alignment. Distribution places designs equidistant across a distance. This is useful if 
you want to make regular patterns, such as a tiled design. If you would like items distributed across an area, move 
the first and last items to the outside areas that you want to fill. In this example, the (top, left) ‘A’ and the (bottom, 
right) ‘A’ make the design size. But notice how the ‘A’ designs between those are not placed regularly? Distribute 
will make those ‘A’s into an orderly row: 

 

Using ‘Center’ distribution will distribute these letters evenly, based on each letter’s center. 

If you choose a different edge to distribute with, for instance, Left, then the distribution will be made using the left 
edges of all the designs. This can be useful to create a geometric composition with different sized designs. 
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Mirror X4  

From the Utility menu, select “Mirror X4.” This will call up a window that lets you create a pattern of  
designs, copied from the current selection, and pasted into mirrored corners. 

To change the values, you can click the arrows next to each value, or type in a value and then click on another one 
to set it. As you change the values, you will see your result on the main view. Click OK to accept your new designs. 

 

Above: An example of a Mirror X4 design. 

Notice how the preview enables you to see the pattern as you adjust it.  This preview is quite helpful if you are try-
ing to fit a specific area, for example the hoop. 

Note: The initial design will be the (top, left) design, and the copies will go to the right and down. 

Scatter 

From the Utility menu, select “Scatter.” This will call up a window that lets you create a pattern of designs, copied 
from the current selection, and pasted in random locations based on your dialog box selections. 

To change the values, you can click the arrows next to each value, or type in a value and then click on another one 
to set it. As you change the values, you will see your result on the main view.  Click on New Pattern to generate a 
new random pattern based on the selected values. Click OK to accept your new designs. 

 

Above: An example of a Scatter design. 

Notice how the preview enables you to see the pattern as you adjust it, which helps if you’re trying to fit an area, 
for example the hoop. 

Note: This is a way to get a random repeat of similar designs. 
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Instant Repeat (Advanced)  

From the Utility menu, select “Instant Repeat.” This will call up a window that lets you create a pattern of designs, 
copied from the current selection, and pasted in rows and columns. 

 

To change the values, you can click the arrows next to each value, or type in a value and then click on another one 
to set it. As you change the values, you will see your result on the main view. Click OK to accept your new designs. 

 

      

Above: An example of a repeated design and the Instant Repeat controls. 

 

Notice how the preview enables you to see the pattern as you adjust it, which helps if you’re trying to fit an area, 
for example the hoop. 

 

Note: The initial design will be the (top, left) design, and the copies will go to the right and down. 

Precise Posit ion (Advanced) 

 

You can precisely position designs using these controls in the Advanced version of the program. The three buttons 
on the (top, left) control the display of the x-axis position. There are Left, Center and Right, which means that when 
you have the Left button set, the display will be of the left edge of the design. 

 

 

 

Similarly, the bottom three buttons control the vertical axis, top, center and bottom respectively. The position con-
trols are very useful for creating tiled patterns. 

 

Your best friends will be the top ruler and left ruler along the edge of the Design Page. You will notice that center of 
the ruler is “0”. To the left of “0” is -. To the right of “0” is plus.  Let’s place a design on the design page and get 
started with Precise Position! 
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1. Decide what size embroidery hoop you are going to use and open it onto the Design Page. You will notice 

that there are four quadrants inside the hoop. 

2. Open a design onto the design page. 

3. Place the design in the top left quadrant. Note the numbers in the x and y location boxes. (-47.17 and 50.25) 

 

 

 

4. Select the design and right click to copy and then right click to Paste the design. 

5. Click on Flip Horizontally .  

6. Delete the “-“ from 47.53 and hit enter. This will move the copied design to the right top corner. 

7. Select the design and right click to copy and then right click to Paste the design. 

8. Click on Flip Vertically.  

9. Place a “-“ next to 50.14 in the y location box. (-50.14) 

10. Hit enter. The design moves to the bottom right corner. 



Transform Controls   

 

39 

 
11. Copy and paste the design in bottom right corner. 

12. Click on Flip Horizontally. 

13. Place a “-“ next to 47.53 (-47. 53) in the x location box. Hit Enter. 

14. Your frame is now complete! 

 

 

This is a great way to align your designs without the frustration of where you placed the first design and how to get 
the others to follow suit. 
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Carousel (Advanced) 

From the Utility menu, select “Carousel.” This will call up a window that lets you create a pattern of designs, copied 
from the current selection, and pasted in an elliptical fashion 

 

To change the values, you can click the arrows next to each value, or type in a value and then click on another one 
to set it. As you change the values, you will see your result on the main view. Click OK to accept your new designs. 

 

                                                

Above: An example of a Carousel design. 

 

Notice how the preview enables you to see the pattern as you adjust it, which helps if you’re trying to fit an area, 
for example the hoop. 

 

Note: The initial design will be the (top, left) design, and the copies will go to the right and around. 
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STITCH FILES 

Clicking the Merge Stitch File tool found on the Design Toolbar or selecting Merge from the File menu will display 
the Open Design Files dialog. Here you browse for embroidery designs to add to the Design Page. 

                       

Left: Merge Stitch tool icon. Right: Menu option. 

 

The Merge Design view allows you to browse thumbnails of your files and select one or more files in import. 

• The Size control of this dialog determines the preview size of the design thumbnails (the design does not 

have to be selected for the determined size). The 3D control shows the preview in 3D, i.e. it shows simu-

lated stitches. 

• Click the Import control to bring the selected design(s) into the Design Page. The imported design will be 

centered on the Design Page. 

 

Merged Stitch File behind Monogram 
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The Sweep  

The Sweep function, which is run from the button with the broom on it, will remove hidden and nested 
stitches within designs, as well as removing hidden stitches where designs are overlapped. 

 

These patented filters operate on the colors of a design to help reduce the stitch count, removing excessive 
overlays and stitches that tend to ‘ball up’ on the underside of the fabric. 

Removing hidden stitches occurs as the program examines the design, looking for color layers that overlap more 
than is necessary for compensation. If stitches of one color layer are on top of the stitches for another color, and 
those stitches are not visible, they can usually be removed. Stitches that would be overlapped at the edges of the 
colors are important for the design so as not to have gaps, thus they are not removed. What you get is a reduction is 
stitch counts, a reduction in sewing time and a reduction in puckering. 

Note that the Sweep is different from the process that removes stitches from overlapping designs. The Sweep op-
erates within a single design, whereas overlapped designs are ones that are merged in separately and then laid on 
top of each other. The processes are similar, but different in that way. Another difference is that the Sweep filters 
are not temporary; they are re-run on the designs as they are adjusted (for instance by sizing.) 

De-Clumping is a process where stitches within a single color are eliminated if they will gather up in small areas. 
These clumps of stitches can often prevent the hoop from moving freely by forming a ball under the fabric which 
can anchor the needle in one area. When and if the hoop finally pulls away, the user often hears a ‘clunk’ sound and 
their project will probably have a gap, as registration may have been lost. 

Occasionally one of the sweep filters will leave an undesirable result, which is visually evident. As a rule, these fil-
ters do a great job, and if the design looks good on the screen, it will sew nicely. However, if you see something on-
screen that you don’t like, you can prevent the Sweep from running on individual colors using the Stitch Properties 
tab. 

Stitch Properties  

The stitch properties tab appears when a stitch design is selected. There are controls where you can add or remove 
up to 25% of the stitches by increasing or decreasing the density of the selected items. The slider controls will sep-
arately allow the adjustment of satin stitching and fill stitching, which allows very specific control. 

 

Note: You can also prevent Sweep operations for occurring on certain objects or designs when you want to. 

 

 

If you are an EmbroideryWorks Advanced user, there are additional controls which also tie in to the Project Advi-
sor and the StitchPerfect system. 
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Stitch Properties (Advanced)  

The Advanced version of EmbroideryWorks allows for more control of the stitches using our StitchPerfect system. 
The Stitches property tab adds controls to use the project settings from the Project Advisor to remove stitching, 
De-Clump, and limit the density. 

 

 

 

Use Automatic Settings: makes use of the Project Advisor project to identify the fabric density, thickness, stretch 
and material being used. The needle penetrations are then adjusted accordingly. 

 

Limit Density: Certain combinations of fabric and stabilizer have limits on the number of stitches per square milli-
meter. More than that causes poor stitching or puckered fabric. Using the Project Advisor, the limiter will reduce 
the stitch counts in the affected regions. 

 

De-Clump: Within sewing a single color, areas sometimes get too many stitches overlapping in small groups. These 
areas form clumps of thread on the back of the fabric which can become entrapped in the needle plate. Sometimes 
this traps the embroidery in one place and cause loss of registration. De-Clump reduces these stitches. 

 

Remove Underlap (intra-design): Often a design has color layers that have some overlap for the purposes of regis-
tration. However, many times these regions are a result of auto-digitizing and poor results follow. The so-called, 
“Bulletproof Embroidery,” is an example. When stitching enters an area within a design that will be covered by a 
later color, those stitches can often be removed, and that is what this does.  

 

Note: This is different from removing hidden stitches created by overlapping separate designs, such as in a compo-
sition. This filter works within a single design.
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PROJECT ADVISOR 

The Project Advisor is a patented expert system, a form of artificial intelligence, which helps you select sta-
bilizer, needles and hooping techniques for many common projects.  

 

The system also provides instructions, helpful how-to advice and some words of caution when necessary. 
First, you select a project from the list. If your exact project or fabric is not listed, there are enough choices availa-
ble where you can choose something very similar. Next, you can tell the Advisor if your fabric has more or less 
stretch, and you can adjust thickness. The Advisor takes your input in account as it makes its recommendations, 
which are displayed as text in the window. 

 

Both the backing (under the fabric) and topping (on top of the fabric) stabilizers are recommended. 

 

EmbroideryWorks Advanced users will also have the StitchPerfect system, which extends the Project Advisor set-
tings to actually adjust your designs’ stitches for the chosen project. 

 

StitchPerfect (Advanced)   

 

When you have chosen a project, the Advanced version of the program lets you set that project on the design page 
so that the Stitch Perfect filters can use it.  

If you would like to clear your project, you can click on ‘No Project.’ 

The StitchPerfect system stores information such as Fabric, density, stretch and stabilizer to help the filters for 
stitch files minimize the pucker and gather that occurs when designs are used on lighter fabrics than for which they 
were digitized. 
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OTHER UTILITIES 

Add Knockdown Stitching Utility  

When sewing on terry or any fabric with loops and nap, generally a topping 
stabilizer is used. These can be helpful, but have a limitation: They do not 
hold down the nap past the actual stitch, which means outlines can be lost 
in the surrounding fabric. Using the menu Utility->Add Knockdown Stitches 
you can create a gloabal underlay for the entire design. The underlay ex-
tends a few millimeters past the edge of the design, which helps the overall 
effect. 

 

 

 

Save Image  

You can quickly save a transparent .PNG file of your design page with this item, found on the Utility menu. 

This is useful for putting designs on the web, in print, etc. The images above were created with this utility.
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OTHER PREFERENCES 

There are a number of preferences for the program and design page that can be adjusted. Click on the Preferences 
button to reveal these controls. 

 

Sizing of  Design Files (Advanced) 

When you resize a regular stitch file, the density would normally get more or less dense, but EmbroideryWorks 
will recalculate the stitches for you automatically. 

 

That recalculation process is complex and difficult, so there are some settings you can adjust to achieve optimal 
results. The sensitivity control is used to control how well the program discovers fills and satin stitches. If you have 
a design which has a lot of manually created stitch effects, then you may want the sensitivity higher, whereas nor-
mal designs that are digitized with objects like fills probably don’t need so much sensitivity, especially if there is 
blending going on. 

• Gap Reduction is a function within the software that helps adjacent areas lessen gaps that might be ex-

posed or widen during increases in size. 

• The stitch length filters are used to prevent loopy stitches on the fabric from stitch elongation, and in the 

other direction, small stitches from gathering on the fabric making too many perforations or simply 

bunching up the fabric. 

The settings are broken out by stitch type because the handling of satin stitches is special and you may want to 
achieve a split-satin look at a certain size. 
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Embroidery Hoops 

 

 

In the Preference window, under Environment, you can choose a hoop. Hoops are displayed in a sorted list, orga-
nized by embroidery file format. Most embroidery hoops are made using the metric system, so the sizes for the 
hoops are displayed according to the way the manufacturer sells the hoop. 

There are two types of hoops offered by EmbroideryWorks. Those are Normal hoops and Multi-Position hoops. 
Multi-Position hoops are those which offer more sewing area than the machine can sew at one time. So the hoop 
(or fabric) gets repositioned to allow a larger design to be sewn. 

There are many hoops that are built into the program, and you can add your own. As the program updates over 
time, or if you have edited a hoop, you can use the “Defaults” button to restore the program to the hoops provided. 
The “Default” button will not, however, remove any hoops you’ve added yourself. 

Many times you will want to sew a design sideways in the hoop. But rather than laying out your design sideways, it 
might be convenient to have the hoop displayed as rotated. Checking the “Rotate 90” button accomplishes this. 

If you have added a hoop, or if you decide to have the program display only the hoops which you own, you can de-
lete hoops from the list, using the “Delete” button. 

You can create hoops and edit hoops too. 

 

The width and height fields are self-explanatory, and you can name your hoop as desired. Hoop names should be 
unique. Note that in the Everyday version of EmbroideryWorks you cannot create or edit Multi-Position hoops, but 
you can do this in Advanced. 

Note: Do not create a hoop that is bigger than the sewing field of your embroidery machine. 
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File  Conversion  

Designs can be saved into many different formats. The Conversion Preference allows you to adjust some parame-
ters when you save in those different formats. 

 

The file format itself may have inherent limitations on the number of colors or stitches, such as the 16 color limit in 
.PCS. But there are also machine limitations too. Older machines which use the .PES format had limits of 100 colors, 
whereas the newer ones can go to 127. To help you save files correctly for your machine, there are options for 
some formats, such as .PES. 

PES Files have to support two distinct machine types, and also have different data for the support of card read-
er/writers which many .PES machines required. Let’s look at the .PES options more closely. 

“Use version 5 and later for real threads.” This setting exists because the version 5 of the Palette/PE-Design soft-
ware, which invented the .PES file, added support for real thread colors. This was a wonderful addition for this 
format. However, if you own an earlier version of the software, and you want to use files created in Embroi-
deryWorks, then you need to leave this set to “Force version 1.” The reason is simple: The old software simply can-
not open those version 5 files. 

The Machine specific settings are for machines like the Ellegante which takes the 180 x 300 hoop (while other ma-
chines may not be able to accept this hoop, so why write a file for it.) Or the multi-needle machines, which have 
their embroidery field rotated to a landscape position. So a 200x300 or a 300x200 field, while technically the same 
size, have different rotational parameters. 

Certainly you know if you have a multi-position machine, or require the use of older software to write your card. If 
not, or if you are distributing these designs, please just leave the settings as-is. The program actually finds a Lowest 
Common Denominator in the format that it will output, making the file available to the widest range of users. 

DST and EXP Files have a different type of information contained in them where it pertains to jump stitches. Ra-
ther, those formats have to have some number of “Jump” commands in a row before they will cycle their thread 
trimmer. When making a DST file, and converting from something else, these jump commands need to be translat-
ed. As machines differ in setup for the number of commands needed to cycle the trimmers, we offer this setting in 
the conversion preferences. 
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Preferred Stitch Format  

Most embroiderers have one machine or other that they use most for embroidery and that machine has a format 
that it uses. To save time, the format that you choose here will automatically be selected during the save. 

 

Removing Overlaps Preference  

When creating a composition, you can arrange designs so that they overlap. EmbroideryWorks automatically re-
moves the overlapped stitches using our patented system. When you save your design, the stitches will be auto-
matically removed. If you prefer this not to happen, uncheck the box and click Apply. 

 

Auto Recover 

Auto recover will save your file in a separate space every so often. This is adjusted using the slider. This feature is 
useful when working on a complex arrangement where a power outage or program crash (unlikely) or freeze by 
the operating system (it happens) could force the program to quit and you might lose your work. If you are work-
ing while power-outs are happening, well, turn this on. And don’t run your embroidery machine; brown outs are 
not good for them. 

Checking For Updates 

The program can check for updates if it is running on a system connected to the internet. This will occur once each 
day, the first time that you run the program. The program does not send your information or anything about you or 
your computer to us. It merely checks the current version available online for your program and if there’s an up-
date, it lets you know. If you don’t want this, you can turn this off. 

You can also check for updates at any time from the option in the Help menu.
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LETTERING 

Creating a simple letter design or monogram is, well, simple! Just click the Create Letters tool found on the Design 
Toolbar. This action will place the new lettering in the center of the design page and display the Letters Property 
tab. 

 

Lettering Button 

 

Design Toolbar  

Monograms vs.  Letters 

Traditionally, monograms were a single letter—“mono” meaning one and “gram” referring to the letter. Today 
most monograms are 3-letter combinations with the center letter larger than the outer two.  

Fonts or letters styled specifically for such monograms are prefixed with “MGM” to easily distinguish them from 
more standard fonts. Of course, you can make a monogram with any font style and use the enveloping features to 
shape the design. 

 

Monogram using MGM Diamond 

 

Monogram Properties on the Single Line Page 
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Now, set the monogram to your desired value by typing into the Text box and pressing the ‘Enter’ key. 

 

Selecting Letter Type  

Although the fonts prefixed with “MGM” are designed for traditional three-letter monograms, you are by no means 
restricted to three letters. For example, if you just want the large center letter, enter a space and the character you 
want. 

 

Type a space before a letter for a large single letter 

 

For fun, you can use a monogram font with entire words. This method works best with all capital letters and short-
er words. 

 

Sample above uses MGM Rounded applied to a word. 

 

Overlapping letters is sometimes needed for your design, and when you do that within a lettering object, the stitch-
es that are hidden will be removed automatically: 
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Customize the Design  

The Letters Property tab provides a number of tools that allow the design to be customized. 

There are three basic styles for lettering: 

• Multi-Line Text 

• Single line of text or Monograms 

• Text on a Circle 

The lettering design can switch between these styles using the three buttons at the top of the property tab as 
shown above. 

Multi-Line Text is useful when you want to enter an entire saying, poem, etc. 

 

Single line of text or Monograms is useful for entering a single line of text or a Monogram. With a single line of text 
there is more flexibility in the shape such as the enveloping feature. With Mono-
grams there are some fun Quick Styles that re-shape the 3-letter monogram and 
when overlapping the monogram letters the Sewing Order finishes the look. 

 

 

 

 

 

Circle Text wraps around a circle. If you overflow the amount of letters that can fit on the circle, you will see your 
text spiral outwards. To see the text on a circle, you will have to adjust the ‘Radius’ of the circle using the slider. 

         

Spiral text starts in the center. 

 

When writing on a circle, you have the option to put text either on the inside or outside; when embroidering, we 
usually think of this as text at the bottom or top of a circular patch or badge. To switch this, use the checkbox la-
beled “Place on bottom.” 
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Monogram Font and Quick Style  

The font and style are changed using the selections in the Font and Quick Style boxes. 

 

Quick Style menu 

When the lettering is initially placed on the page, the letters are automatically kerned (letter spacing) for a good 
visual effect. Note that these styles are designed to accomplish traditional monograms, and therefore some only 
work properly with two or three letters. 

Font Selection 

Some fonts may only have uppercase letters. If you’re using a font and not seeing the desired characters, clicking 
the ‘?’ button to the right of the Font box; it will display all characters available in the selected font along with size 
recommendations. 

 

Characters available shown with recommended size ranges. 

Slant and Space 

The slant of the monogram and the spacing of the monogram letters are controlled with the Slant and Space slider 
controls. If you use these controls and want to return the monogram to its default settings, simply click the zero 
control. This will restore the default setting. The Slant gives an italic effect to the monogram. 

. 

Enveloping 
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The envelope (containing top and bottom outlines) of the lettering (single or multi-line) can be individually cus-
tomized. The Envelope Type box and Envelope Slider control the envelope. There is an Envelope Slider control for 
the envelope top and there is an envelope slider control for the envelope bottom. There are four styles of envelope: 
Curve, Grow, Peak and Shrink. 

If you use these controls and want to return the lettering to its default settings simply click the zero control. 

 

Enveloping 

 

Curved Top and Bottom Envelope 

 

Enveloping can produce a variety of creative designs, especially when you begin breaking up the words into seg-
ments and enveloping each one separately. 

 

Sample above uses two envelopes and a lower case “o” resized for bubbles. 

 

Changing the Color of  one Letter  

You can change the color of one letter by selecting that one letter. To select it, first make 
sure the lettering object or monogram is selected, then click on the green handle that 
appears centered over the letter you want to change. Once a single letter is selected, you 
can change the color(s) of just that one letter using the color property page as described 
previously. 

For more information on threads and colors, see the section on Color. 
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Monogram Sewing Order  

On the Letters tab there is a Sewing Order box. Choose the order in which the letters are sewn from this control. 
For a simple monogram you probably do not want to change the default order. However, if you want to overlap the 
center letter on the others, you could choose the ‘ACB’ order (second choice). 

Stitch Properties 

The Stitch tab contains controls for the actual stitch generation of the Lettering. 

 

Note: This tab will not be displayed for imported fonts, as those designs are different in nature.  

 

 

Auto Fill: If you want the lettering design to be a satin stitch at any size, un-
check this box. This prevents the program from switching this design to a fill 
as it gets larger. 

 

Fill control: When switching to a fill, there are options for the pattern to be 
used. Click the arrow on the right to open the list. 

 

Satin Density Control: This control ranges from 3 to 20 with each tick being 
one tenth of a millimeter. So the range in millimeters is .3 to 2.0 mm. The 
smaller the density number the closer together the satin stitches will be. 
0.4mm is normal. 

 

Compensation: This control ranges from 0 to 10 with each tick being .1 mil-
limeter. As the value increases the stitch length increases, in effect ‘fattening’ 

the stitching. This is useful on fabrics that have a loft or nap, and can also be used to make a font appear bolder.  

 

Remove Hidden Stitches: When selected, stitches that are completely hidden by top stitches will be removed. This 
process allows the design to sew out in a flatter manner. Note that this only affects stitching within the monogram 
itself. 

 

Edge Run: When checked, this adds a running stitch underlay. This setting is the amount of inset for the edge run 
and ranges from .1 to 1.2 mm.  

 

Satin: When checked, this adds a satin underlay. When checked, it applies the density value, which ranges from .3 
to 2.0 mm just like the satin stitch. 

 

The ‘Set Defaults’ button restores each of these controls to their default values.
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IMPORTING FONTS (ADVANCED) 

There are many great fonts in the world, and lots of design companies are digitizing fonts as regular stitch files. The 
difficulty with these comes in using them: The letters have to be imported one at a time, there is no baseline, the 
sewing order can be messed up if you copy and paste; sizing and color sorting are issues to be managed too! Plus it 
would be nice to use the envelopes and text path tools that are used for the built-in keyboard lettering fonts. 

For this reason, we have created the ability to import alphabet designs! This window is brought up from the Utility 
menu item, “Import Font…” and it lets you import fonts as well as manage ones you’ve already imported. Let’s take 
a look at the Import Font dialog box as it contains the mapping shortcuts as well as other useful information and 
tools.  The following numbered picture shows you the tools and buttons in groups as they will be described below: 

 

1. This shows you the name of the folder that you have selected.  Below this is the name of the font 
as it will be shown in the font list of your program.  You may change the font name and this infor-
mation will be saved with it and displayed in your font list. 

2. We have set the default spacing between letters and words which will be perfectly fine for most 
fonts that you map.  If you find that these settings need adjusting, you may do so here and these 
values will be saved with your font.  Included in the spacing section is a pulldown menu for the 
baseline.  For most fonts that reside on a line, you would want the baseline to be at the bottom – a 
reference where the bottom most part of the design is.  However, for some decorative or monogram 
alphabets, you may decide that the baseline should be at the Center or Top, so this maybe changed 
in the pulldown menu. 

3. Here we have the buttons for adding a New font, Saving a mapped font, Deleting a font you have 
previously mapped and to Add Designs to an existing mapped font. 

4. The trashcan button allows you to remove the current letter from the mapping process.  The Let-
ter: shows you the name of the current design – once it has been mapped, this field will show you 
the character on the keyboard that corresponds to the currently viewed letter. 

5. The MGM pulldown is for mapping monogram alphabets – is the current letter a Left, Center, or 
Right monogram letter. 

6. The Map: buttons are “quick mapping” tools that you can use for fonts that have been named se-
quentially and are displayed as such in this dialog. 
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Let’s get started. Click the button ‘New Font…” This brings up the window which allows you to browse and import 
design files. Since you are importing a whole font, find the folder with the font and click  ‘Sel. All’ to select all the 
designs. If your folder contains designs that are not specifically part of the font itself, you might want to use the 
ctrl-click to de-select those files. 

 

It is important that all the files for the font are together in one folder for easier and complete mapping. If you dis-
cover that some files are missing, for instance the “0”-“9” designs, you can open this font at a later time, choose Add 
Designs and resave your font. 

 

Mapping Letters  

Once you have the designs loaded into the window, you will have to map them to keystrokes. The field marked 
“Letter:” lets you type a character on your keyboard which will map to the current design. The current design is 
boxed in by black lines in the view on the right. In the picture at the start of this section, the number ‘2’ is selected. 

 

If you have a set of designs where all the letters or numbers line up next to each other, you have some shortcuts 
provided for you to map the keyboard to the designs. You’ll see the buttons “A-Z”, “a-z” and “0-9.” As an example, 
click on the design that is the letter “A” to select it. Then click the “A-Z” button. This will automatically map the A-Z 
letters to those 26 designs. 

Speed tip: 
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Map any punctuation characters first. The mapping buttons ‘A-Z’ etc will skip over the punctuation, and al-
low mapping around them. 

If your designs are organized in some other order then you will have to manually type those keys to map the font. 

Adjusting Baseline  

 

Sometimes individual letters require adjustments for their baseline. In the view, the pictures 
of each letter are shown, with a black line representing the baseline. You can click on a letter 
to select it, and once selected, drag the letter up or down as necessary to place it relative to 
the baseline as you like. 

Some things like apostrophes always need adjustment, naturally, but letters with descenders like “g” or “y” will 
usually need adjustment also. 

Spacing 

The spacing of letters between each letter and each word can be set using these boxes. The spacing is always a per-
centage of the font height. 

 

Editing Fonts Already Imported  

 

Use the Font box to select a font that you want to edit. Once the font loads, you can make adjustments to the font, 
such as remapping letters, adjusting sizes or positions on baseline, etc. When you have the font how you want it, 
click “Save Font.” 

If your font is missing letters that you have now located, use the Add Designs button to open the Import dialog box 
to select and add the missing letters.  You will need to map these new letters and save the font. 

Note: Fonts must be named uniquely. If you accidentally name a font the same as an existing on, it will get a (2) 
added to the name. 

Another Note: Long font names may run past the visible space on the font selection in the Letter properties, so we 
recommend shortening the font names using initials or abbreviations. Do this in the Name line under the Font list 
box. 
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Using Imported Fonts  

 

When you create a lettering design, you can now use the font that you’ve imported. Im-
ported fonts are indicated with a needle overlaid on their icon, as seen on the picture to 
the left. These fonts can do almost everything that the built in fonts can do, such as make 
monograms, circles and even be shaped. When these letters get sized, the built-in sizing 
technology will recalculate their stitches. 

 

There are however, no stitch properties for these fonts, as they are stitch-files, not our dig-
itized objects. So removing of hidden stitches, underlay and density cannot be changed, for 
example. 

 

MONOGRAM PLACEMENT 

Towels 

General Instructions: The placement goes on the opposite side of the fabric and at the opposite end from the la-
bel. This allows a traditional triple fold to display the monogram. Folding the towel as you would display it helps 
visualizing and marking the correct placement. 

Bath Towel: The bottom of the monogram should be 4” above the hem or 1”to 2” above the dobby border, if pre-
sent. The monogram should be 4” tall.  

Beach Towel: The bottom of the monogram should be 5” above the hem or 2”to 3” above the dobby border, if pre-
sent. The monogram should be 5” tall.  

Golf Towel: The monogram should be centered horizontally with the top of the monogram .5” below the grommet. 
The monogram should be 1”to 2” tall. 

Hand Towel: The bottom of the monogram should be 2” above the hem or 1” to 1.5” above the dobby border, if 
present. The monogram should be 3” tall. 

 Sports Towel: The bottom of the monogram should be 1.5” above the hem. The monogram should be 1.5” 
tall, and may be placed on a 45 degree angle. 

Wash Cloth: The bottom of the monogram should be 1.5” above the hem or 1” above the dobby border, if present. 
The monogram should be 1.5” tall and may be placed on a 45 degree angle. 

Bedding 

General Instructions: Don’t annoy your sleeper. Placement and thread can affect the comfort of the item. Spread 
out the item as you would see it on a well-made bed to help with visualizing and marking the correct placement. 

Top Sheet: Top Sheets are placed on a bed upside-down and the top (wide hem) is then folded back to right-side-
up. This means that the monogram is apparently embroidered upside down. Looking at a made-up bed will help 
you visualize this. Place the bottom of the monogram 2” from the wide hem, centered. The monogram should be 
3”to 4” tall. Embroidering inside the wide hem is sometimes preferred, and when doing so the design is sized to fit. 

Pillowcase: Embroidering inside the wide hem is generally preferred, and when doing so the design is sized to fit. 
If the font allows it, the monogram should be 2.5”to 3” tall. Placement is centered, monogram facing toward the 
opening. 
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Pillow Sham: Center the design on the sham, facing the long edge as if it were a pillowcase with an opening. The 
monogram should be 2.5”to 4” tall. 

Blanket: Centered on the top like a sheet or facing into the bottom, right corner at a 45 degree angle. The mono-
gram should be 4” tall. 

Duvet Cover: Centered on the top. The monogram should be large, up to 12” tall. 

Home Decor 

General Instructions: None. This is all according to taste, fashion and style. 

Napkin: Embroider 2” in from point of corner. Distance may need to be increased if there’s a border or hem. Place 
opposite of label or tag. The monogram should be 1”to 2” tall. 

Placemat: Top-right corner, 3” diagonally from point of corner. The monogram should be 1”to 2” tall. 

Table Runner: Embroider matching designs 4” from end. The monogram should be 4”to 5” tall. 

Table Cloth: Embroider 4” from corner, with design facing into corner at a 45 degree angle. The monogram should 
be 4”to 6” tall. 

Garments 

Coat Lining: Embroider on the right side at the waist level, 3” from the seam. Monograms should be 1” to 1.25” tall. 

Collar: Embroider on the left side, above buttonhole if present. Monograms should be 3/8” tall. 

Golf/Polo Shirt: 7.5” to 9” below the shoulders left seam and 4” to 6” from center. Depending on the design, you 
can also look for a line down from where the collar meets the shoulder seam, and look over from the 2nd button-
hole. 

Long Sleeve Shirt: Top and center of wrist, which is about 1” to 1.25” from the center toward the buttonhole. The 
bottom of the monogram should sit very near the top stitching of the cuff. Monograms should be 3/8” tall. 

Robe: Draw a line straight down from the shoulder seam 4” to 6” for women and 7” to 10” for men. Find the center 
of the armholes from the armpit to the shoulder, and draw line straight across toward the center of the robe or go 
across 3” to 5” from the center.  

Shirt Placket: Center the design between 2nd and 3rd buttonholes. The design should be 1/4” to 3/8” inch tall. 

Shirt with no pocket: Draw a line straight down from where the shoulder seam meets the collar seam. Find the 
center of the armholes from the armpit to the shoulder, and draw line straight across toward the center of the shirt. 
The center of the design is marked where the lines intersect. If the arm holes are deep, the line can be made too low 
on a woman’s shirt, so keep that in mind. 

Shirt with pocket: Center the design on the pocket hem, with the top of the design 1/4” below the top of the pock-
et. Monograms should be 1/4 to 3/8” tall. If pocket has button in center, shift design to the right. 

Shorts Leg: Halfway between center-front and side seam. The bottom of the design should be 1/4”to 1/2” above 
the hem stitching at the leg hole.    

Short Sleeve Shirt: Center design 1/4”to 1/2” above the hem on the sleeve. Monograms should be 1/4”to 3/8” tall.



EW Library 

 

 

61 

THE EW LIBRARY 

Clicking the Library tool found on the Design Toolbar will display the selection dialog.  

 

The dialog has a pulldown list at the top that allows you to select from different library collections that may be 
available to you depending on the version of the software that you have.  Next to this pulldown menu is the Import 
Catalog (.bx) button that allows you to install new library collections.  

 

The dialog has a scrolling list on the left that shows the collections. Select a collection from the list on the left and 
designs in that category display in the selection area on the right. Select a design and click OK. The design will be 
placed in the center of the Design Page. 

 

Thread Brand and Color:  

The thread brand and color are changed just as described in Color section. 
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THE ACCUQUILT LIBRARIES 

Various families of the AccuQuilt dies have been made available as embroidery applique files in the library func-
tion.  They are first downloaded from the Designer’s Gallery website, then use the button “Import catalog (.bx)” to 
load the individual catalogs. These catalogs will grow and change over time as AccuQuilt releases new dies. 

 

Select the family from the catalog pulldown menu and 
choose the die you wish to use from the list on the left.  
The individual pieces may be selected one at a time, All at 
once (using either CTRL+A or the “Select All” button) or 
multiple selections using the CTRL or Shift keys.   

 

 

 

 

 

 

Click OK to insert the current selection into the center of the design page. 

 

Each die-cut design that is inserted has its own properties that can be modified. 

Thread Brand and Color:  

The thread brand and color are changed just as described in Color section.  The color of the Fabric preview is calcu-
lated from the color of the finishing stitch. 
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Applique Properties Tab 

 

This tab becomes active when you have an applique shape from the Library selected. The default is to not show the 
fabric of the applique shapes.  This feature will give you a realistic view of the finished design, and can be turned on 
by selecting the Fabric Preview option. 

 

The border style pulldown menu allows you to change the finishing stitch type.  In this example you can see the E-
Stitch is selected and will hug the edge of the precut AccuQuilt die for professional and clean results. With pre-cut 
appliqués a heavy satin-stitched border is no longer necessary, saving time and thread while improving the fin-
ished look. 
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The Topstitch (finishing stitch) properties can be adjusted in this section.  You may type in values for the Stitch 
Length and Stitch Width or you may use the slider control for each value on the right.   

 

The Color style allows users to adjust how they work with color during appliqué steps. There are two styles: Keep 
Color and PES Card (Traditional). 

Use Keep Color to conserve thread changes by combining like colored Top Stitch and next position placement 
stitches.  This will allow the machine to stitch the finishing stitch of the piece and the placement stitch of the next 
piece (if the same color) without having to start the machine again. 

For traditional stops after each section, you may select the PES Card option from the Color type pulldown.  This se-
lection may be necessary depending on your machine, particularly if you use Palette Basic or similar to write a PES 
card for your machine. 

Once you have selected a color style, the program will remember it as your choice for next time.
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MULTI-POSITION HOOPING 

SO, YOU SAW IT ON THE INTERNET AND HAD TO HAVE IT.  

BUT IT’S TOO BIG FOR  YOUR MACHINE…  

EmbroideryWorks has our patented design splitting technology built into it. This system automatically splits de-
signs into multiple positions for sewing as separate designs which tile together to make a larger design. In the past, 
splitting a design took hours of editing by a person schooled in the process. 

 

Our splitting drastically reduces the visible ‘seams’ that occur from manually splitting files using an editor. In most 
cases, the final product is indistinguishable from one created on a larger-field machine. 

 

Some hoops have multiple positions. This means that you only hoop the fabric once and generate the design by 
sewing it in those multiple sections. However, you can achieve the same result by re-hooping the fabric multiple 
times to create the design. We call this a “Virtual Hoop.” The Everyday version of the program comes with many 
hoops and virtual hoops pre-defined. The Advanced version has creation and editing of these hoops as well. 

When sewing designs in multiple sections, often the question of alignment comes up. This is accomplished auto-
matically with multi-position hoops, but to make it easier for regular hoops, the program will add basting stitches 
which will align the designs. To choose a hoop, click the preferences button on the toolbar, and the Hoops window 
will appear: 

 

The Multi-Position hoops are separated from the Normal hoops, and you click on the Hoop Style to select which list 
you want to see. Here is the Jumbo Frame: 
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Sewing 

You’ll notice that this hoop has two rectangles, which overlap in the middle. Each of these represents a sewing 
field. To make it more obvious which lines represent which field, the inside of each rectangle has a dotted line indi-
cating the inside of the field. 

If you are combining designs to make a composition, it is always going to give the best result if you keep whole de-
signs into one region. This produces a split which will have the least effect on the actual stitches on the design. Of 
course, this is not necessary, however, as the design may be split even if it lies in the middle of the hoop, but some 
splitting would have to occur. 

 

The ‘+’ marks shown indicate the centers of the sewing fields.  

 

Note: If you look at the Hoop in the selection window you will see a note that the design centers are offset from 
each other. This means that when you sew the two sections, the centers of each design will be separated by that 
amount. This is your initial placement method for each design. 

 

 

 

In order to position your design, it is always advisable to print an actual template of the design. This helps you vis-
ualize what it will look like once embroidered, and it will help define the center position of the design on the fabric. 
Once you have the center of the overall design, then you will want to mark the centers for the individual fields. In 
the example above, this would mean that you mark the fabric 5 cm. from the center on both the left and right of the 
design center. This places the two designs 10 cm. apart. This basic positioning will help you get the result onto the 
fabric where you want it to go. 

Editing the Hoops (Advanced) 

When you click the “New” or “Edit” button in the Hoops Available window, you will see this screen: 
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EXPLANATION OF FIELDS: 

• The first field in this window is the ‘Hoop Name’. This is just what it sounds like. Type in whatever 

name you want. 

• Next, choose the ‘File Type’ of the machine that this hoop works on. The list contains the file types that 

can be saved. 

• The ‘Individual Field Size’ is the size (in mm) that your embroidery machine can create with a single 

hoop position. If you are unsure about this size, consult your dealer. 

• The ‘Rows’ field specifies the number of vertical points at which the hoop can be attached to your ma-

chine. For most multi-position hoops, this number is three. For sliding hoops such as those made by 

Hoop-It-All, you will have to determine how many sections you want to embroider in. In so doing, how-

ever, keep in mind that there should be a good overlap between adjoining sections. Use the hoops we’ve 

provided as examples. 

• The ‘Columns’ field specifies the number of points at which the hoop can be attached to your machine 

sideways. For most hoops, this number is one, but there are exceptions on the market. These are usually 

described as “Double-Wide”. You can also use the columns to indicate that you want to divide the design 

into horizontally-tiled segments. 

• The ‘Separation’ fields specify the distance between the hoop positions. (For example, the distance from 

needle-center of the top position to the needle-center of the middle position.) This can be measured phys-

ically if you do not know: hoop a piece of paper and drop the needle through it, in all hoop positions, 

measuring the distance between the holes. Alternately, most manufacturers’ software will show a grid 

behind the hoop on the screen. You can count the grids (usually 1 grid = 10mm) between the region 

marks to get the separation. It is very important that you correctly assign the separation; otherwise the de-

sign will not be split accurately. 

• The ‘Right-to-Left’ field is used for multi-column hoops (‘Double-Wide’). It indicates that the initial di-

rection the program will split the design will be right-to-left, as opposed to the standard, left-to-right. The 

use of this depends on the machine and hoop. Some manufacturers have wide hoops that start by sewing 

the left side of the design upside-down, then you turn the hoop halfway around and embroider the other 

side (now the right side, and the design is right-side-up). Hence, the default, ‘Left-to-Right.  

 

NOTE: You can tell if your separation figure is correct! The manufacturer of the hoop will definitely provide you 
with the number of positions used as well as the full size of the embroidering region of the hoop. As you adjust the 
separation, the field, “Overall Size” is calculated. If this matches the figure given to you by the manufacturer, you 
have correctly set your separation. 

 

• ‘Compensation’ allows the final regions to be slightly increased in size. This forces the regions to overlap 

each other. This is useful because as the machine adds stitches, the fabric gathers slightly. It is entirely 

possible to have a gap between regions if no compensation were to be used. The amount of compensation 

required depends on several factors: The size of the hoop, the fabric being embroidered, the number of 

stitches, the quality of the stabilization, etc. We have chosen some settings for our factory hoops that 

have worked well in our design testing. Please embroider some test designs with the desired hoop before 

tackling a project. This will ensure that you have a reasonable setting for your compensation. 

• ‘Color-by-Color’ denotes a different type of file splitting. As of this writing, only the Viking Mega 

Hoop™ allows for this type of design splitting, so as a general rule, never check this box. The Color -by-

Color method is for use in machines that can sew each color in all of the hoop regions before going on to 

the next color. When the machine operates this way, it will stitch in its current region until it no longer 

can. It will then stop and ask the user to reposition the hoop, whereupon it will continue stitching. In the 
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case of most designs, this will cause a lot of position switching as a color typically stitches objects out in 

a random fashion all over the design. The program will ‘sort’ the stitch objects to reduce the number of 

position-switches required. 

• ‘Invert Alternate Column’ is used for ‘Double-Wide’ hoops that get turned upside-down for their second 

row.  

• ‘Add basting alignment lines’ will provide a basted line of stitching to each output file. These lines of 

stitching will have their end and/or center points line up on the fabric when you go to stitch out the de-

signs. If the lines do not line up, then adjust your hoop/fabric position until they do. 

• ‘Baste Length’ sets the size of the alignment line stitching, in mm. 

Once you have finished creating or editing your hoop, simply click, ‘Save’ to save it. 

If it is a new hoop, it will then appear in the Hoop Available window. 

Multiple Hooping 

Multiple Hooping is the process of creating a large embroidery design by re-hooping the fabric as you embroider 
each section. Multiple Hooping is an art that requires a complete understanding of what you are doing, as well as 
an excellent ability for placing your fabric in the hoop. It is not a method that should be practiced by the timid. You 
can split designs for Multiple Hooping by creating your own hoop: 

Suppose you have a design that is 9 inches high and 8 inches wide. Also, suppose that your machine will embroider 
a region 9 inches high and 6 inches wide. (These are typical values for today’s machines.) What you want to do is to 
create a two-position hoop to accomplish the split. 

Therefore, create a hoop that is 9 inches high, with two positions. The separation should be set to allow the great-
est possible overlap between the two regions: 8 inches (desired) - 6 inches (a single hoop width) = 2 inches. 

A separation of 2” would be the smallest possible for the desired 8-inch width, and would provide the greatest 
overlap of the regions.  

Note: The use of columns allows side-by-side multiple-position hoops. It’s a lot of embroidering, but it looks good 
and can easily fill a jacket back. 

It is very important to mark your fabric before embroidering. When the fabric is re-hooped it must be parallel and 
centered to the first hooping. Also, the distance between the centers needs to be precise. (This is 2 inches in this 
example.) 

If it is possible, we encourage the use of ‘Floating’ techniques for hooping: not actually hooping the material itself, 
but rather hooping a stabilizer and attaching the fabric to it with adhesive and/or a basting stitch. This will provide 
the least distortion in the fabric while the overlapped regions of the design are being embroidered. One easy meth-
od, if your material can handle it, is to use carpet tape (double-sided and very sticky) on the bottom of your tight-
ened hoop. This can then be perfectly aligned and pressed into place. (The adhesive comes off with a lot of water-
soluble solvents and even soapy water will usually work.) 

Remember: 

It is a really good idea to take a class on this type of process to get the hang of it, and practice before moving on to 
an actual project! 
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Split  Into Hoop (Advanced)  

You can split the design using the “Split Into Hoop” from the Utility menu. This will open a new design page with 
the split files so that you can preview them or do other work before saving. 

 

     

Left: A single design placed on a 100x172 hoop.     Right: The design has been split. 

 

In the example above, the 100 x 172 PES hoop was chosen, and the design was centered in it. Then the menu item, 
Utility->Split Into Hoop was chosen. This created a new design page, represented by a new tab. In that page there 
are two designs, one for the top hoop section, and one for the bottom. Using ghost mode, we show the designs sep-
arately: 

 

    

Left: The top design is selected.   Right: The bottom design is selected. 

 

When you save this page, multiple stitch files will be created, as described in the next section, “Output Files.” 
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Output Files 

When you save your files, the output files represent each region of your design. 

The files are automatically given names indicating their stitching order as well as the position within the hoop. For 
instance, “Rose.Pes” may split into “Rose Top #1.Pes” and “Rose Bottom #2.Pes”.  

Additionally, you may get a text file that explains the color sequence for your new files. In many designs, a color is 
only needed in one region. Where this is the case, that color will not exist in all the output files. To help reduce this 
“Color Confusion”, a text file is created with a table. The following is text from an example file: 

 

“Roses.Pes 

Your original file had 3 colors.   

The program has split your file into 2 segments. 

This cross-reference has been created for you because some thread colors in the original file were not needed in 
some of the split segments. 

File: C:\Roses Top #1.PES 

Color 1 = original color 1 

Color 2 = original color 2 

Color 3 = original color 3 

Color 4 = original color 4 

Color 5 = original color 5 

File: C:\Roses Bottom #2.PES 

Color 1 = original color 1 

Color 2 = original color 2 

Color 3 = original color 3 

Happy Embroidering!” 

 

As you can see, the table is easy to follow. Since this is a text file, you can view it in Designer’s Gallery Studio. You 
can also edit it (double-click to launch Notepad), print it, etc. It is a good idea to add any real thread numbers or 
names if you have them. Often, the digitizer of a design will supply a real-color thread list for this purpose. 

We cannot stress enough the fact that the order of embroidering the files is important.  

The files will overlap each other as they sew. If you embroider out-of-order you will get overlapping that is incor-
rect, and parts of your design will not be visible! 

 

Region Naming:  

On hoops that have three positions, the regions are named for you: Top, Center and Bottom. On hoops that have 
more positions, the other positions are given numbers, starting at the top. Hence, you might have a hoop with: Top, 
Pos. 2, Center, Pos. 4 and Bottom. Columns have names like “Left”, “Right” or “C2”. 
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Getting Results  

To get the best results, there are some things you should know. 

First is that you should trim your jump stitches as you go, if your machine does not do it automatically. This is true 
in the course of normal embroidery, but somewhat necessary when embroidering a split design. When splitting a 
design, it is natural that the machine will have to go from place to place a little more frequently. This results in ex-
tra jump stitches. We have made every effort to minimize the amount of effort that it takes to split embroidery files, 
and apologize for any inconvenience this may cause, but please accept our assurance that your finished product 
will have a nicer appearance if you clean the jumps from the design. 

If you are using an appliqué design, you will need to embroider each color in each region before moving on to the 
next color. This will ensure that the full appliqué can be applied without incorrect oversewing by the other colors.  

There is a compensation control in the Hoop Properties window. This control is available on all hoops, even the 
factory-defined ones. Compensation is the amount that each region will overlap the neighboring regions. This is 
used to correct for the fact that fabric will shrink as it is embroidered. Additionally, an imperfectly hooped project 
will allow registration problems to occur. If you are not able to hoop your fabric, ‘Drum-tight’, then you may want 
to increase the compensation setting for your hoop. 

Important: If you are increasing the size of a design in SizeWorks or some other sizing program, please don’t in-
crease the size more than you will actually need for your hoop. 

Note: There is a very important phrase in the computer industry: “Garbage in, garbage out.”
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STITCH EDITING (ADVANCED) 

The ability to edit individual stitches is a very useful tool. Sometimes there are parts of a design that you 
simply do not want. Other times, there are jams of stitches that simply cannot be removed any other way. 
In still other cases, you want to add a few stitches to get rid of gaps or increase coverage in an area that’s 

not necessarily a fill. Maybe you just want to make a pocket topper?  

To begin editing a design’s stitches, click the Stitch Edit button on the toolbar. This will cause the Tool pane to dis-
play the Stitch Edit controls, and the main view will show the stitch points: 

 

 

Stitch points can be turned on or off from the View menu. They help identify the individual needle penetrations in 
the design. 

Selecting Stitches  

The slider control at the top of the Tool pan scrolls through the stitches, highlighting the current one as you scroll. 
You can also move forward or back with the blue arrows. If you hold down the shift key as you scroll, you will be 
able to select a range of stitches. 

Here you can see that we’ve selected a range of stitches inside the golf ball, but we’ve skipped the satin stitches that 
go around the edge. If we hit delete on the keyboard, we can remove them! 
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Another way to select stitches is graphically. You can drag a rectangle or a lasso around stitches to select them. You 
can also use the Brush selection, which selects anything the cursor touches, or with the Ctrl key, the brush can de-
select points. Selected stitches can be deleted with the ‘delete’ key or split using the ‘Split’ button. 

You can also select stitches for an entire object or design using the Object View. While in Stitch Edit mode, simply 
select objects in the tree and the corresponding stitches will be selected. 

        

Left: Lasso.     Right: Selected 

 

Splitting a  design  

Once stitches have been selected, you can delete them or split them, To split them, click the ‘Split’ button. 
This will create a separate design for the selected stitches. It will also remove the stitches from the cur-
rent design. If your design is lettering or a Library design, this process will convert that design to stitch-

es so you will not be able to adjust that design the same as before. 

       

Above, the design has been split, and the crown was copied and pasted. 

 

Insert Stitches 

If you have a stitch selected, you can right-click to get a pop-up menu which will let you insert stitches. 

Notice that you can see the direction of the stitches when you are zoomed in. This helps determine ‘before’ or ‘af-
ter’. The arrow on each stitch points toward the next stitch as the design would sew. 
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Left: Right-click to select the Insert mode. Middle: Inserting stitches.  Right: Stitches have been inserted. 

 

Converting Stitches  

Using the ‘Satin’ Drop-down box, you can convert selected stitches to a satin stitch, a choice of split satin stitches, 
or even add a fill effect to an existing satin stitch. 

 

Adding compensation  

Once stitches have been selected, you can add compensation, which makes the outside stitches of fills or satins a bit 
longer or shorter. This is useful when you have gaps in a stitch-out and you would like to ‘stretch’ the stitches to-
gether, thus reducing or eliminating the gaps. You can also use compensation to adjust the width of lettering you 
may have imported. 

     

Left: a typically gapped design. Middle: The stitches around the gap are selected. Right: Compensation has been 
added by moving the slider to the right. 
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Keyboard Shortcuts  

 

Left Arrow: Select Backwards 

Right Arrow:  Select Forward 

Up Arrow: Select Forwards 10 stitches 

Down Arrow: Select Backwards 10 stitches 

Page Up: Select next command (jump or color) 

Page Down: Select previous command 

Home:  Select First stitch 

End:  Select last Stitch 

Delete:  Delete selected stitches 

Shift Left Arrow: Range select backwards 

Shift Right Arrow:  Range select forward 

Shift Up Arrow: Range select forwards 10 stitches 

Shift Down Arrow: Range select backwards 10 stitches 

Shift Page Up:  Range select next command (jump or color) 

Shift Page Down: Range select to previous command 

Shift Home:  Range select to first stitch 

Shift End:  Range select to last Stitch 
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STITCH SIMULATOR 

The Stitch Simulator lets you see how the design will sew out by sewing on the screen. It is activated by clicking the 
Stitch Simulator tool in the View tool bar or selecting Stitch Simulator from the View menu. 

 

Stitch Simulator controls 

  

Stitch Simulator Controls 

The controls are easy to use and give complete control of the simulated sewing process. 

 

Player Control: This control lets you sew forward, backward and stop. The right arrow starts sewing forward. The 
double bars stop sewing. The left arrow starts sewing backward. 

 

Step Stitch Control: This control lets you sew one stitch at a time forward or backward. Right arrow: forward. Left 
arrow: backward. 

 

Speed Control: Use the slider to change the speed of sewing. Move to the left for slower to the right for faster. 

 

Manual Control: Click and drag this slider forward or backward to quickly move a particular section of the design. 

 

Stop Control: Click the Stop button to insert a color stop in the design. This allows you to change colors on the fly. 
Or creatively use this to isolate parts of the design that you want to remove or isolate. 
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THE DENSITY MAP 

The Density Map is a graphical display of the density, or stitches-per-inch in your designs. To see the Den-
sity Map, click the button on the main toolbar. This is useful to see if a design is not going to sew well. For 
instance, this is a design that has been overlapped, thus its density is very high. 

 

Like weather radar, the density map shows areas where trouble is likely: 

 

Where the design shows bright red in color, there are six layers or more of thread, which undoubtedly will produce 
poor embroidery results. 

The Density Map can be used to illustrate when a design (probably from the internet) is dangerous to sew on a pro-
ject without test sewing it first. And it also helps identify when you would want to you’re the Remove Hidden 
Stitches function or even the Sweep. Those features will remove stitches that are likely to cause poor design pro-
duction, while maintaining the same visual design. Here is the same design after a Sweep is performed: 
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BASTING FUNCTIONS 

Individually selected designs can have a basting stitch added automatically. This is useful when you want to add a 
layer of stabilizer or some other material before the sewing of a design. 

Also a basting stitch can be added to the hoop, which allows for a layer of topping stabilizer to be basted in place 
before any designs are sewn. A typical use of this is to add a layer of water-soluable topping to a towel, which will 
prevent the terry cloth loops from coming up through the embroidery. It can be hard to hoop a towel, and the top-
ping stabilizer will want to slide around before the stitching happens, so basting it first can make the process easi-
er. 

 

The basting stitches are added to the start of the design or file, and are added as a separate color; naturally you can 
use any color you want to sew the baste. 

PRINTING 

A design template showing the design at full size and with registration marks can be printed. Just choose print 
from the File menu. 

 

On the left are common options for printing templates. This includes 3D and crosshairs which mark the center of 
the design for hoop placement. Also you can choose not to print design information (Design Only). 

Several options have been included for use with Applique. See the Applique section for images and a description of 
using the Applique. 
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 ‘Selected Colors only’, which can be used with machines that will scan and cut – by printing only an outline, 
you could make it easier for those machines to scan the shape you need. 

 When printing an applique for hand-cutting you probably want to turn the ‘Print Applique Outline’ mode 
on so that you have a clean, dark line to cut on.  

 The ‘Print Stitches’ option is used to only print a background image, for use with creating a photograph as 
an applique via printable fabric or transfer fabric. There, you want to print the image, not the stitches 
which will be applied over top. 

 ‘Print Applique’ is a setting that turns on printing of a selected Simulated Fill or photograph (on the ap-
plique tab of the Color Window.  

 And ‘Mirror’ is useful for transfer paper as the image will be reversed. 

‘Print Color Sequence’ adds a separate page with all the colors, see the following images: 

 

The template can be previewed before sending the output to the printer. Below is a sample template with a mono-
gram surrounded by a frame. Note the registration marks. 

 

The second page of the worksheet displays size, stitch and color counts, and a list of the colors used in the design 
with approximate thread requirements. 

 

Printing preferences, found in the Program Preferences window.
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HELP 

Getting help for EmbroideryWorks products is just a few clicks away!  

www.designersgallerysoftware.com 

 

 

 

 


